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1. Introduction 

This guide helps you: 

• Download and install the Dostek DNC software. 

• Understand the Dostek DNC software license. 

• Protect your investment by backing up data, minimizing downtime and quickly recovering from 
problems. 

• Troubleshoot problems that may occur while installing or using Dostek DNC software, or while 
transferring files between Dostek DNC and your CNC machine tools. 

• How to report problems to Memex, and how to send information such as screen images and 
configuration files to Memex. 

• How to build cables to connect your computer to CNC machines (Appendix E, “Building RS-232C 
Cables.” 

Requirements 

Dostek DNC works with: 

• Computers equipped with Windows 10, Windows 8 or Windows 7.  

• Machine tools equipped with an RS-232C or RS-422 serial port or with a parallel tape reader 

port. A Memex 440A Behind-the-Tape Reader (BTR) interface is required to work with a 

machine tool’s parallel tape reader interface. 

• An RS-232C serial port or adapter with a Windows COM port driver is required. To use remote 

DNC commands, a separate serial port is required for each machine. A single-port Memex DA-

S1E3 or Moxa Ethernet/RS-232C adapter is recommended to ensure reliable operation and 

provide electrical isolation to reduce the risk of equipment damage. Other adapters may be 

used, including USB/serial adapters. However, many of these devices include poorly designed 

firmware or device driver software that can present problems when used for DNC. 

Dostek DNC License Key 

Your Dostek DNC software licence key entitles you to use the Dostek DNC software version you 

purchase. Free updates are available for one year. If you lose your software disk or download, you 

may need to purchase a software update to download the current version. Make backup copies of your 

software disk or download, your Dostek DNC configuration files, and your license key file. For more 

information, see Section 3, “Understanding your Dostek DNC Software License” and Section 4, 

“Making Backups.” 
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Dostek DNC Free Trial 

You can download a free trial of the Dostek DNC software from the Memex Web site.  

The free trial is fully functional and works for 10 days. To extend the free trial or install it on a 

computer that Dostek DNC was previously installed on, request a free temporary license key from 

Memex.  

When you purchase Dostek DNC, you receive a license key by email that activates the software.  

Using Dostek DNC User Guide 

The Dostek DNC User Guide is installed on your computer as a PDF file when you install Dostek DNC. 

Use either of the following methods to open the User Guide: 

• Open Dostek DNC File Manager (DFileMgr), point to Documents in DFileMgr’s Help menu, and 

then click Dostek DNC User Guide (PDF). 

• Open Dostek DNC Navigator, select the Documents tab, and then click Dostek DNC User 

Guide. 

Minimizing DNC Downtime 

To minimize downtime for your Dostek DNC system: 

• Use the sample CNC configurations included with the Dostek DNC software. 

• Use a newer computer and maintain it well. Using an old or improperly maintained computer to 

save cost now can result in costly production loss later. 

• Keep spares for your communication hardware (Ethernet/RS-232C adapter, 440A BTR, etc.) so 

you can quickly swap devices when a problem occurs. 

• Keep a backup copy of your Dostek DNC software and configuration files in a safe place where 

easily found. 

• Consider installing your Dostek DNC software on a backup computer. Test the backup periodically 

to ensure it will be ready when needed. When a backup computer is available, you can quickly 
switch computers to restore production, and then troubleshoot the problem as time permits. If 
your backup computer is portable (such as a laptop), then you can use it to connect directly to 
your machines should the shop network or cabling fail (requires installing a COM port in your 
laptop and configuring your Dostek DNC software). 

• Prepare a written recovery procedure. Explain the steps required to repair or replace your 
computer. Test your procedure. 
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2. Installing Dostek DNC 

To install Dostek DNC, follow these steps: 

1. Prepare your computer’s communications ports. 

2. Download the Dostek DNC installer. 

3. Run the installer. 

4. Complete the Dostek DNC First-Time Setup Wizard. 

5. Get started with Dostek DNC. 

Each step is described in the following sections. 

1.1 Preparing the Computer’s Communication Ports 

Prepare the computer’s communication ports before you install the Dostek DNC software. For more 

information, see Appendix D, “Moving Communication Hardware.”  

1.2 Downloading the Dostek DNC Installer. 

Download the Dostek DNC installer by clicking the link on the Dostek DNC page in the Memex Web 

site, or by clicking the link in the registration email you receive from Memex with your software license 

key. 

Your computer or anti-virus software may warn you about installing unknown software and may try to 

prevent you from continuing. Continue, if possible. For example, in the following Windows dialog, 

clicking More info (see red arrow) opens a window that lets you continue. 

 

Alternately, you can temporarily disable Windows Defender or your antivirus software. 

1.3 Running the Dostek DNC Installer 

Open the downloaded Dostek DNC installer. Some Web browsers place a link or button at the bottom 

of the window. Most browsers store downloaded files in the computer’s Downloads folder. Open the 

Downloads folder in Windows Explorer, and then find and open the Dostek DNC installer. 

The installer is named “DDWvvvvv” with either an “EXE” or “ZIP” file type. For example, the installer 

for version 15.12A is “DDW1512A” 

If you encounter a problem during installation, you may need to perform the installation by logging in 

to a Windows account with administrator privileges, or you may need to right-click the installer file in 

Windows Explorer and then choose “Run as administrator.” 
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1.4 Completing the First-Time Installation Wizard 

The Dostek DNC installer automatically launches the Dostek DNC First-Time Installation Wizard when 

software installation is completed. 

The First-Time Installation Wizard walks you through first-time configuration of your Dostek DNC 

software, including: 

• reviewing the Dostek DNC Getting Started Guide 

• activating your Dostek DNC software license 

• specifying the location of your CNC program files 

• selecting sample DNC configurations to work with your CNC machines 

• informing you how to protect your investment in Dostek DNC software 

 

To ensure a successful installation, carefully complete each step. Most problems with new Dostek DNC 

installations result from rushing. Take a few extra minutes now. It could save you an hour or more of 

troubleshooting later. 

 

Choosing Setup Mode 

The Wizard prompts you to select a setup mode: 

New installation. Choose this mode when you are installing Dostek DNC for the first time. 

Keep existing configuration. Choose this mode when you are reinstalling Dostek DNC to upgrade to 

a newer version or to repair the current installation. Dostek DNC terminates the Wizard and keeps 

your existing configuration files. 

Load previously saved configuration. Choose this mode when you are moving Dostek DNC to a 

different computer, or repairing a defective installation, and wish to load the Dostek DNC configuration 

files you previously backed-up. 
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Reviewing Getting Started Guide 

The Wizard automatically displays the Dostek DNC Getting Started help document. If you are new with 

Dostek DNC, taking a few minutes to read the Getting Started will help you get started as quickly as 

possible.  

Activating your License 

You receive your license key from Memex by email when you register. If you saved the Dostek DNC 

software license key on your Windows desktop, the Wizard registers it for you, and displays the 

“Confirm License” page. 

 

If the Dostek DNC installer does not find a license key, you can enter your license data manually, or 

click Skip to install Dostek DNC as a 10-day free trial.  

If you choose to enter your license information manually, you must enter it exactly as indicated in 

your registration confirmation email. If you type a character with the wrong case or insert or omit a 

space, registration will fail. 
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Specifying a File Location 

The Wizard prompts you to enter the location of your CNC program files. You can type a path, click the 

Browse button to select an existing folder, or click the link to create a default “CNC Programs” folder.  

If you leave the location blank, Dostek DNC shows all files on your computer’s “C” drive. 

If you decide to change the file location later, simply click Root folders in Dostek DNC File Manager’s 

Configure menu. 

If you are upgrading from a previous version of Dostek DNC, and you wish to use your existing CNC 

configurations, you can click Cancel to close the Wizard, and then copy your configuration files as 

explained in “Upgrading from a Previous Version,” below.   

Selecting Sample CNC Configurations 

IMPORTANT! Don’t skip this step! 

Dostek DNC includes sample configurations for more than 100 CNC models. Using the provided sample 

configurations ensures reliable operation and greatly simplifies installation and support. 

Understanding and using Dostek DNC’s sample configurations may take you a few extra minutes but 

can save you an hour or more of frustrating troubleshooting. 

When prompted by the Wizard to import sample CNC configuration files, select all the samples that 

match your machines.  

 

 

Notes 

• Sample configurations are named according to manufacturer and control model. You can change 

the name to suit your preference. For example: “HMC45”, “HMC45#1”, “HMC45 Horizontal Boring 
Mill”, or “Acme HMC45”. 

• If each machine is connected to the computer using a different computer COM port, you need to 

create a separate configuration for each machine. If multiple machines are equipped with the 
same control model, import the sample configuration once, and then click Save as in the 
Configuration window’s File menu to make additional configurations. 
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• You can add more machines using sample configurations later by opening the Dostek DNC 

Configuration window and clicking Import sample configurations in the File menu. 

• While Memex provides limited free support for Dostek DNC, free support may be available only 
when you use the provided sample CNC configurations. 

• Even if you are an experienced CNC communication expert, using Dostek DNC’s sample 
configurations can save you time. 

Reviewing Common Problems 

The Wizard cautions you about two of the most common problems: USB/Serial adapters and computer 

power hibernation. Carefully review these warnings. For more information about DNC problems caused 

by USB/serial adapters, see Appendix C, “Working with USB/Serial Adapters”. 

Backing up your Data 

The Wizard advises you about backing up your data. Take a few moments to read the help topic.  

1.5 Upgrading from a Previous Version 

To upgrade your Dostek DNC system: 

• If you plan to use your current RS-232C communication hardware, move it to the new computer. 
See Appendix D, “Installing Communication Hardware,” for more information. 

• Install the new version of the Dostek DNC software. 

• Copy your existing Dostek DNC configuration files from the previous computer, or from a backup 

copy. If you failed to save backup copies of your configuration files, you will need to completely 
reconfigure and test Dostek DNC’s communication settings. 

If you are installing a newer version on the same computer, and the previous version is 15 (2015) or 

later, then simply install the new version. Dostek DNC will use your existing Dostek DNC configuration 

files. 

If you are installing Dostek DNC on a new computer, or your previous Dostek DNC software version is 

older than version 15, then upgrade as follows: 

1. Install Dostek DNC as explained above.  

2. Copy all “DCP” files from the previous installation to a USB flash drive or shared network folder. 

You will typically find the DCP files in the “C:\Dostek DNC\Settings” folder for versions prior to 

2015, or in the “C:\ProgramData\Dostek DNC\Settings” folder for version 2015 and later. 

3. Copy the DCP files from the USB flash drive or shared network folder to the 

“C:\ProgramData\Dostek DNC\Settings” folder on the new computer.  

4. Restart Dostek DNC.  

1.6 Getting Started with Dostek DNC 

To start with Dostek DNC, open Dostek DNC File Manager by clicking the link in the Windows menu or 

desktop.   
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3. Understanding your Dostek DNC Software License 

When you purchase Dostek DNC software, you receive a confirmation message by email. The message 

includes the following information about your license key: 

• Software edition 

• Number of computers licensed 

• License type and expiry date: 

o Standard. License to use purchased version never expires. 

o Trial. Expires after the trial period (usually 10 to 30 days). 

o Demo. Dealer demonstration license. Must be renewed annually. 

• Support expiry date 

• License key data 

The terms and conditions of your software license include: 

1. You are responsible for safeguarding your software download, your license key, your 

configurations files, and your data. If you lose your Dostek DNC software file, you may need to 

purchase an update to download the current version. Only the current version is available for 

download. If you lose your Dostek DNC configuration files, you will need to reconfigure your 

computer from the start. Technical support is available from Memex at nominal cost. 

2. Your standard Dostek DNC software license key never expires. However: 

o Your license entitles you to free updates for one year from purchase. To obtain software 
updates thereafter, you must either purchase an update or subscribe a Memex support plan. 

o Your license does not entitle you to free replacement. You are responsible for making backup 
copies of your Dostek DNC software download files. If you lose your Dostek DNC software, you 

must purchase a software update to obtain the current version. For more information, see 
Section 4, "Making Backups." 

3. You may use Dostek DNC software on the number of computers specified by your software 

license key. To use Dostek DNC on additional computers, contact Memex to purchase additional 

software licenses at reduced cost. Purchasing an additional license (for an additional computer) 

does not include a software update. 

4. You are permitted to install your Dostek DNC software on one spare computer for backup or 

testing purposes only (for example, to permit you to quickly replace your primary computer if it 

stops working). 
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4. Making Backups 

To ensure you can reinstall your Dostek DNC software when you repair or replace your computer, 

make backup copies up your Dostek DNC software disk or download, license key and configuration 

files.  

4.1 Backing up your Dostek DNC Software 

If you received your Dostek DNC software on a disk or USB flash drive: 

• Make backup copies of the disk 

• Store the original disk and your backup copies in multiple locations where you can find them 

when you need them.  

If you received your Dostek DNC software by download: 

• Make backup copies of the download file. 

• Store the backup copies on multiple computers where you can find them when you need them. 

Starting with Dostek DNC version 15, a copy of the Dostek DNC software installer file is stored in on 

your computer when you install Dostek DNC. This means you have everything you need to completely 

reinstall Dostek DNC if you have backup copies of the “C:\ProgramData\Dostek DNC” folder on your 

computer.  

4.2 Backing up your Dostek DNC Configuration Files 

The location of your Dostek DNC configuration files depends on the software version. 

4.2.1 Backing up Version 15 Files 

Dostek DNC version 15 stores data files, including configuration files and license, in the following 

folder: 

C:\ProgramData\Dostek DNC 

To make a backup copy, copy the entire folder. You can use a free compression tool, such as WinZip 

or 7-Zip, to store the entire content in a single file. 

4.2.2 Backing up Earlier Versions 

Dostek DNC versions prior to version 15 stored configuration and license files in the following folder: 

C:\Dostek DNC\Settings 

To make a backup copy, copy the entire folder. 
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5. Troubleshooting Problems 

To quickly recover from a problem with your Dostek DNC system, you can: 

• Prepare ahead by installing your Dostek DNC software on a spare computer. 

• Install your Dostek DNC software on a different computer. 

If you are unable to find your Dostek DNC software or your backup copies: 

• If you received a printed Dostek DNC manual, look inside the front cover for a small CD-ROM disk 
containing your software. 

• Search your computers for files matching “DDW*.exe” or “DDW*.zip”. 

• Download and install the Dostek DNC free trial on a new computer. The free trial works for 10 
days, providing you time to find your backup copies or purchase a software update from Memex. 

 

The following topics help you quickly resolve problems: 

• Basic Troubleshooting 

• Using Sample CNC Configurations  

• Using Help  

• Using Communication Testing and Troubleshooting Help  

o RS-232C signals, ports and cables 

o Test procedures 

o Frequently asked questions  

• Fixing a CNC Communication Problem  

• Installing and Configuring Dostek DNC  

• Fixing a Software Operation Problem 

• General troubleshooting tips 
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5.1 Basic Troubleshooting 

If you encounter a problem when using Dostek DNC for the first time, the most common reasons are: 

• You failed to use the Dostek DNC sample configuration for your control model, or you failed to 
configure the CNC communication parameter settings as instructed in the “Notes” section of the 
Dostek DNC sample configuration. Use Dostek DNC’s standard configurations as explained in 

section 5.2, below. 

• Your computer’s COM port is defective, or its device driver software is faulty or is not installed. 

Use a Memex DA-S1E3 DNC adapter, a Moxa NPort Ethernet/RS-232C adapter, or a Digi Edgeport 
USB/serial adapter. Ensure your COM port device driver software is up to date.  

• The cable connecting your computer to the CNC machine is wired incorrectly or is defective. See 

Merlin DNC’s Communication Testing and Troubleshooting help document for information about 
cable wiring and for detailed testing and troubleshooting procedures. For information about using 
Dostek DNC’s help topics, see Section 5.3, “Using Help” and Section 5.4, “Using Communication 

Testing and Troubleshooting Help,” below. 

If you encounter a problem after using Dostek DNC successfully for some time, the most common 

reasons are: 

• The computer’s serial COM port or cable has failed. 

• There is a syntax or format error in the file you are trying to send to the machine. Try sending a 
problem you have successfully sent previously. 

To solve a problem such as a computer failure or a communication error:  

• If your computer and software work, but you are having trouble communicating with a machine, 
see Section 5.5, "Fixing a CNC Communication Problem." 

• If your computer or Dostek DNC software stop working, install your Dostek DNC software on 
another computer. If you can't find your Dostek DNC software disk, download the free trial from 

the Memex Web site. It works for 10 days without a license.  

• If you encounter a problem with your network, COM port or cable, install your Dostek DNC 
software on a laptop computer and connect it directly to the machine. 

To ensure you can quickly recover from a problem, see Section 4.3, “Recovering from Problems.”  
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5.2 Using Sample CNC Configurations 

To save time, use Dostek DNC's sample CNC configuration files. Samples are provided for more than 

100 CNC models, and they include the information you need to configure your CNC (in the "Notes" 

tab).  

To use a sample configuration: 

1. Open the Dostek DNC Configuration window (DConfig). For example, click Communication 

(CNC) settings in Dostek DNC File Manager’s Configure menu. 

2. Click Import sample configuration in DConfig’s File menu. 

3. Select a sample configuration from the list of available samples, and then click Open. The sample 

configuration import wizard opens. Follow the Wizard prompts to complete importing the sample 

configuration. 

4. Click the “Notes” tab in the imported configuration, and then carefully read the comments and 

configure the CNC communication parameters as instructed. After you configure the CNC 

parameters, restart the machine and verify that any modified parameters retained their new 

values. 
 

Note 

• When you contact Memex for free support, you will be asked to confirm you are using a Dostek 
DNC sample configuration or instructed to start using the sample configuration. Free support may 
not be available for non-standard configurations because of the extra time required to 
troubleshoot non-standard configurations. However, affordable paid support is always available. 

5.3 Using Help 

To view Dostek DNC's detailed help topics, you can: 

• Click Help in the menu in any Dostek DNC window.  

• Open Dostek DNC Navigator to the "Help" tab for access to all help documents. Click Master 
Help to view all help documents at once. To start Navigator, click Navigator in the Help menu in 
Dostek DNC, or in the Dostek DNC folder in the Windows Start Menu.  

• Click the "Search" tab to quickly find topics by searching for words or text.  
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5.4 Using Communication Testing and Troubleshooting Help 

The Dostek DNC Communication Testing and Troubleshooting help 

module (Comtest) includes detailed information including: 

• Fixing CNC communication problems  

• Testing ports and cables  

• Recommended cable diagrams  

• Frequently asked questions 

To open the Communication Testing and Troubleshooting help 

document: 

1. In Dostek DNC File Manager (DFileMgr), point to Help topics in 

the Help menu, and then click Communication testing. The 

help document opens.  

2. In Contents, choose a help topic. 

 

To find a recommended solution to a communication problem, click 

Problem Index in Contents, and then find the topic that most closely matches the problem. 

For a list of test procedures, click Test Procedures in Contents. 

Additional test procedures and troubleshooting tips are provided in the Dostek DNC COM Test Terminal 

(DTerminal) help file. To view DTerminal’s help topics: 

1. Click Com Test Terminal (DTerminal) in Dostek DNC File Manager’s Tools menu. DTerminal 

opens. 

2. Point to Help topics in DTerminal’s Help menu, and then click DTerminal. The help document 

opens.  

5.5 Fixing a CNC Communication Problem 

If you encounter a problem when you upload, download or drip feed: 

• View the Communication Testing and Troubleshooting help file for detailed recommendations for 
typical communication problems. Go to the Problem Topics section and find the topic heading that 
most closely describes your problem. For a link to the help file, see Dostek DNC Navigator's Help 

tab. 

• If you are not already using a Dostek DNC sample configuration, try using one now. See Section 

5.2, “Using Sample CNC Configurations.” 

• Write down, print or save a screen image of every error message displayed on the computer or 

CNC (see Section 6.1, "Sending Screen Images"). 

• If the CNC displays an alarm, find the alarm description in the CNC manual and write it down or 
make a copy of the manual page. 

• Keep notes. Before you change anything (on the computer or the CNC), write down the current 
setting, the new setting, and the reason for the change. 
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5.7 Fixing a Software Installation Problem 

If you encounter a problem while installing the Dostek DNC software: 

• Write down, print or save a screen image of every error message (see Section 6.1, "Sending 
Screen Images." 

• To install the software, log on to your computer using an account with administrator privileges. 

• Ensure that all other Windows applications are closed before starting the installation.  

• Carefully read and follow all messages and instructions displayed on your computer screen during 

installation.  

• Fully complete the Dostek DNC First-Time Setup Wizard. It opens automatically when the 

software installation is completed.  

• Try installing Dostek DNC on a different computer. There may be a problem with your computer. 

Windows computers can become unstable over time due to viruses, spyware, registry corruption, 
installation of non-compliant applications, and so on.   

5.8 Fixing a Software Operation Problem 

If you encounter a problem when you open the Dostek DNC software or perform a specific task: 

• Write down, print or save a screen image of every error message (see Section 6.1, "Sending 
Screen Images." 

• Write down exactly what you were attempting to do when the problem occurred, including the 
commands or key sequences you pressed. 

• Restart the computer and try again. Windows computers can become unstable or low on 
resources. 

• Ensure the computer's disk drive is not full. 

• If you are attempting to access files on a network resource, ensure the network is working 
properly and your user account has sufficient network privileges.   
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5.9 Fixing a File Access Problem 

If Dostek DNC reports a file access problem (access denied or unable to create or write to a file), your 

Windows user account may not have permission to access a file or folder. This can happen if you 

install Dostek DNC using an administrator account and then use Dostek DNC with a normal user 

account, or when you change file or folder permissions after installing Dostek DNC.  

If you encounter a problem accessing a Dostek DNC configuration file: 

• Open Dostek DNC Configuration, change a setting, and then click Save in the File menu. If an 
error message is displayed, your user account may not have permission to write to Dostek DNC's 

Settings folder. 

If you encounter a problem editing, creating or deleting a part program file: 

• Open the file in Windows Notepad, make a change, and then click Save in the File menu. If an 

error message is displayed, your user account may not have permission to write to the selected 

file and folder. 

To correct a file access problem, either: 

• Search the Web for "windows change file permissions," and follow the instructions. 

• Contact your IT help desk or consultant. 

5.10 Fixing a Remote DNC Problem 

To fix a problem with remote save or remote load (remote callup) when using Dostek DNC Remote 

Server (DRemote), see the “Test Remote Commands” section in DRemote’s help document: 

1. Open DRemote. 

2. Point to Help topics in DRemote’s Help menu and then click Testing remote operation. 
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5.11 General Troubleshooting Tips 

DNC communication requires all the following to be configured and working properly: 

The Dostek DNC communication settings. 

• Use the correct Dostek DNC sample configuration for the specific CNC model. 

• Dostek DNC is configured to use 7 data bits and even parity for most applications. This works for 
ISO standard CNC part programs. The sample configuration may instruct you to configure the 
CNC for 8 data bits and no parity. Although this does not match the Dostek DNC settings, it is 
correct. This is because the Dostek DNC software uses the computer COM port to generate the 

required parity, while the CNC deals with parity in software. 

The CNC communication parameter settings. 

• Configure the CNC communication parameter settings as recommended in the notes section of 

the appropriate Dostek DNC sample configuration. 

The computer’s COM port. 

• Ensure the COM port device driver software is installed. 

• If the COM port is USB/serial, expect problems. Especially with those using Prolific chipsets. See 
the Dostek technical note. 

• If multiple COM ports are installed, ensure the cable from the CNC is plugged into the correct 
port, and that Dostek DNC is configured to use the correct port. 

• Connect a different CNC to the computer COM port (and configure Dostek DNC accordingly). If 
communication works with a different CNC, the computer COM port is not likely causing the 

problem. 

• Perform a loopback test to verify the port works properly. The Communication Testing and 
Troubleshooting help file includes a detailed procedure. 

The CNC’s RS-232C serial port. 

• Although most CNCs have only one physical serial port exposed to the outside, they may have 
multiple physical or logical ports. Ensure the correct port is configured by configuring the CNC 

parameters as recommended in the corresponding Dostek DNC sample CNC configuration. 

• Try sending with the cable a) plugged in and b) not plugged in. If the CNC displays different error 

messages or alarm codes for each case, the CNC is most likely configured to use the correct serial 
port. However, the same indication is likely if the cable is incorrectly wired or is defective. 

• The Communication Testing and Troubleshooting help file includes detailed instructions for testing 

CNC serial ports. 
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The cable connecting the computer COM port to the CNC serial port. 

• Test the cable. The Communication Testing and Troubleshooting help file includes detailed 
procedures. Or, you can try swapping with a cable that is known to work. Some customer cables 
are wired incorrectly or poorly constructed. The Communication Testing and Troubleshooting help 
file includes recommended cable wiring. The Dostek DNC sample configuration includes a cable 

diagram for those requiring special cable wiring. 

The operator (must execute the correct commands in the correct sequence) 

• CNC operating procedures can be arbitrary and complex. The operator may be new to the 

machine. If possible, ask the operator to describe each step of the process, and then verify the 
correct procedure is used. The procedure may be included in the Notes section of the Dostek DNC 
sample configuration. Or, obtain a copy of the necessary CNC user manual. 
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6. Sending Information to Memex 

This section helps you send information such as screen images, files, captured CNC output data and 

BTR configuration data to Memex by email. 

6.1 Sending Screen Images 

To capture a screen image (such as an error message) and send it to Memex: 

1. Press the computer's PrtScrn key. A snapshot of the current screen image is saved to the 

Windows Clipboard. (Note: To save a snapshot of only the current window rather than the entire 

screen, press Alt+PrtScrn.) 

2. Click Run in the Windows Start menu. The Run dialog opens. 

3. Type PAINT (or MSPAINT for older computers) and then press Enter. Windows Paint (a graphic 

editor) opens. 

4. Press Ctrl+V. The captured screen snapshot is pasted into Windows Paint.  

5. Click Save as in Paint's File menu. The Save As dialog appears: 

 

6. On the "Save As" dialog: 

o Select a file location using Save in. [1] 

o Type a file name in the File name box. [2] 

o Select "PNG" in Save as type. [3] Selecting "PNG" reduces the size of the file, so it is easier 
to send by e-mail. 

o Click Save. The file is saved. [4]  

  



Dostek DNC Installation and Troubleshooting Guide    19  
2019-11-21 

 

8. Click Send in email (or Send for older computers) in Paint's File menu. A new email message 

opens with the saved image attached. Type support@MemexOEE.com in the To box, and then 

click Send. (Note: If an e-mail client is not installed on your computer, see Section 4.2, "Sending 

Files.") 

6.2 Sending Files 

This section explains how to send files to Memex support, including: 

• Dostek DNC configuration files 

• Dostek DNC log files 

• Data files 

• Dostek MultiPort DNC messages 

• Dostek MultiPort DNC received file 

• Dostek MultiPort DNC feedback message file 

To send files to Memex, attach the files to an e-mail message addressed to 

"support@MemexOEE.com". 

If your computer does not have an e-mail client installed, copy the files to another computer using a 

USB memory device, a removable disk, or a shared network folder. 

Sending Dostek DNC Configuration Files 

To send Dostek DNC configuration files: 

• Open Dostek DNC Configuration (DConfig). 

• Point to Explore in DConfig's Tools menu, and then click Dostek DNC\Settings. The Dostek 

DNC "Settings" folder opens in a new Explorer window. 

• Select one or more files or press Ctrl+A to select all files. 

• Point to Send in Explorer's File menu, and then click Mail Recipient. A new e-mail message is 
opened, with the selected files attached. 

 

Note 

• If the computer does not have an e-mail client installed, click Copy to folder in Explorer's Edit 
menu, save the files to a network folder or removable media, and then attach the files to an 
email message using another computer. 

Sending Dostek DNC Log Files 

To send Dostek DNC log files, follow the procedure above, except click Dostek DNC\Log in step #2.    
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Sending Data Files 

To send data files: 

1. Right-click the Windows Start button, and then click Explore in the context menu. A new Windows 

Explorer window opens. 

2. Browse to the folder containing the data files you wish to send. 

3. Select one or more data files. 

4. Point to Send to in Explorer's File menu, and then click Mail Recipient. A new e-mail message is 

opened, with the selected files attached. 
 

Notes 

• If the computer does not have an e-mail client installed, click Copy to folder in Explorer's Edit 

menu, and save the files to a network folder or removable media. 

• If you are sending many files, or files that are very large, use WinZip (or similar) file compression 
software to condense and combine the files into a single file. 

Sending Dostek DNC Remote Server Messages 

To send Dostek DNC Remote Server (DRemote) message and log files: 

• Click Copy messages to clipboard in DRemote's Help menu. All recent messages are copied to 
the Windows Clipboard.  

• Open a new e-mail message, and then paste the messages from the Windows Clipboard into the 
message. 

 

Notes 

• If the computer does not have an e-mail client installed, open a new Notepad or Word document 
and then paste the messages into the new document. Save the document to a file and copy the 
file to another computer using a removable disk or shared network folder. 

• To send recent messages for one specific CNC only: 

o Select the CNC in DRemote's CNC list. 

o On the menu, click Channel, point to View and then click Messages.           
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Sending Dostek DNC Remote Server Received File 

To send the content of the most recently received file for a specific CNC:  

1. Select the CNC in DRemote's CNC list. 

2. Point to View in DRemote's Channel menu, and then click Last received file. The most recently 

received file is displayed in the view window.  

3. Open a new e-mail message, and then paste the messages from the Windows Clipboard into the 

message. 
 

Note 

• If the computer does not have an e-mail client installed, open a new Notepad or Word document 
and then paste the messages into the new document. Save the document to a file and copy the 
file to another computer using a removable disk or shared network folder. 

Sending Dostek DNC Remote Server Feedback Message File 

To send the most recent feedback message issued by Dostek DNC Remote Server (DRemote) for a 

specific CNC: 

1. Point to Explore in DRemote's Tools menu, and then click Dostek DNC\Log. The Dostek DNC 

Log folder opens in a new Explorer window. 

2. Select the .fbk file (file with extension ".fbk") matching the name of the CNC. 

3. Point to Send in Explorer's File menu, and then click Mail Recipient. A new e-mail message 

opens, with the selected file attached. 
 

Note 

• If the computer does not have an e-mail client installed, you can save the results to a network 
folder or removable media, and then send the files using another computer. To save the files, 
click Copy to folder in Explorer's File menu. 
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6.3 Sending Captured CNC Output 

This section explains how to: 

• Use Dostek DNC Terminal (DTerminal) to capture data sent from the CNC to the computer.  

• Send the captured data to Dostek. 

To capture and send received data: 

1. Open Dostek DNC Com Test Terminal (DTerminal): 

o If you are using the Dostek DNC File Manager (DFileMgr), click Com Test Terminal in 
DFileMgr's Supervisor menu.  

o If you are using Dostek DNC Remote Server (DRemote), click Com Test Terminal in 
DRemote's Tools menu. Note: To use DTerminal with a COM port, you must "disconnect" the 
channel. See Appendix B, "Disconnecting a MultiPort DNC Channel." 

DTerminal's Device Configuration window opens.  

 

2. Select the CNC whose data you wish to capture, and then click OK.  

3. An information message may appear. Click OK. DTerminal indicates "Connected" on a green 

background. If DTerminal is unable to open the COM port, the port may already in use by another 

window, or the port may not be configured properly.  

4. Configure the DTerminal Options menu as shown. Ensure Flow Control is "None," and only 

"Display typed characters" and "Display control symbols" are checked.  
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5. Set Flow Control to None. 

6. Click Capture to log file in DTerminal's File menu. The "Open communication log file" window 

opens. 

7. Select an existing log file, or type the name of a new log file, and then click OK. 

Note: Use the extension .log or .txt for the log file. This makes it easier to open the file in a text 

editor or attach it to an e-mail message. 

8. Go to the CNC and send the data you wish to capture. Captured data scrolls in the DTerminal 

window, and usually appears something like the example below:  

 

Note: The "^@" and "^J" symbols represent the "Null" and "Line feed" control character that are 

normally not visible. This is normal. You may see other "^" symbols. 

9. Click Capture to log file in DTerminal's File menu again. DTerminal stops capturing data. The "End 

capture" prompt appears. 

10. You can save or edit the captured data or copy the data to the Windows clipboard. To send the 

captured data to Memex by e-mail: 

o Click Clipboard. The captured data is copied to the Windows clipboard. 

o Open a new e-mail message, and then paste the captured data into the e-mail message. 

Note: If the computer does not have an e-mail client installed, paste the captured data into a 

Notepad or Word document, save the document to a network folder or removable drive, and then 

send the document by email using another computer.   
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6.4 Sending Component Version Information 

Dostek DNC includes an application that reports the current version of all the software components it 

uses. 

To send a software component version information to Memex: 

1. Open Dostek DNC Navigator. 

2. Select the Navigator's Test tab, and then click Version Information. The Component Version 

Info window opens. It displays a list of all software components and the current version of each. 

3. In the Component Version Info window, click Copy to Clipboard. The version information is 

copied to the Windows Clipboard. 

4. Open a new e-mail message, paste the captured data into the e-mail message, and send the 

message to Memex. 
 

Notes 

• If Version Information is not visible in the Test tab, open Dostek DNC's component version 
information window manually: 

o Open Windows Explorer. 

o Browse to the "Dostek DNC" folder (usually "C:\Dostek DNC," "C:\Program files\Dostek DNC" 
or "C:\Program files (x86)\Dostek DNC." 

o Locate and double-click DComponentVersionInfo. 

• If the computer does not have an e-mail client installed, save the copy the captured file to 

another computer by a removable drive or a shared network folder. 

6.5 Sending Install Log 

The Dostek DNC software installer creates a log file during installation. The log file helps identify 

installation problems.  

To send the install log file to Memex: 

1. Open Dostek DNC File Manager. 

2. Point to Explore in File Manager’s Tools menu, and then click Dostek DNC. Windows Explorer 

opens to the Dostek DNC program folder. 

3. Find the “InstallLog-Setup..” file. If you installed Dostek DNC multiple times, there will be 

multiple log files; find the newest log file. 

4. Open a new e-mail message, attach the log file to the message, and send the message to 

Memex. 
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6.6 Sending BTR Configuration 

The Dostek DNC Com Test Terminal application includes a feature to capture configuration information 

from a Dostek Model 440A Behind-the-Tape Reader (BTR). 

To send 440A BTR configuration information to Memex: 

1. Ensure the 440A BTR is not already in use. The BTR's 7-segment indicator displays one of the 

following three symbols:  

2. Click Query in DTerminal's BTR440A menu. (Requires DTerminal version 2006.22A or later).  

DTerminal sends a series of commands to the 440A BTR to capture the configuration information. 

The BTR indicates "C" (command mode) for a few seconds during this process. The Results 

window opens with a list of the BTR configuration information.  

3. Click Copy results to Windows Clipboard. The results are copied to the Windows Clipboard. 

4. Open a new e-mail message, and then paste the captured data into the e-mail message. 
 

Note 

• If the computer does not have an e-mail client installed, save the copy the captured file to 
another computer by a removable drive or a shared network folder. 
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7. Contacting Memex 

Memex provides limited free support for Dostek DNC. To get the most from free support, and to obtain 

the fastest response from Memex, first review the following tips: 

• Review Section 5, “Troubleshooting Problems.” 

• Be prepared to provide Memex with the following information: 

o The software version, serial number and licensee. To view this information, click Help, About 
in any of the main Dostek DNC applications. 

o Your computer’s Windows operating system version. 

o If you are reporting a CNC communication problem: The manufacturer and model number of 
the machine’s control (eg: Fanuc 21) and the type, manufacturer and model of the RS-232C 

communication hardware (eg: Moxa NPort 5110). 

• Write down your observations, including all alarm codes and error messages, and a concise 

description of exactly what you were doing when the problem occurred. It is very important to 
indicate whether you were sending a file to the CNC, receiving a file from the CNC, or so on, 
when the problem occurred. 

• When describing the problem, be specific and avoid slang and ambiguous words. For example, 

instead of saying "It quits when I download," say "When I'm sending a file from the computer to 
the CNC, the CNC indicates alarm 86 and the Dostek DNC software stops after sending 14 percent 
of the file and displays the message 'XOff char received'." 

• Provide detailed information about your application: 

o The manufacturer and model number of the machine's numerical control. 

o The Dostek DNC software version number and serial number. To find this information, click 
About in the Help menu. 

o The computer's operating system. For example: "Windows 7 64-bit edition." 

o The communication hardware. For example: "Computer's built-in COM port," or "Moxa 5110 
Ethernet/serial adapter." 

• Provide your full contact information: full name, company name, telephone number and e-mail 
address. 

• If practical, send the following data files to Memex by e-mail: 

o Dostek DNC configuration files (see Section 6.2, "Sending Files"). 

o One or more of the CNC part program files you used when the problem occurred. 

o A screen image of Dostek DNC error messages (see Section 6.1, "Sending Screen Images"). 

o If you are using a Dostek Model 440A BTR, send your BTR's configuration information (see 
Section 6.5, "Sending BTR Configuration"). 

    

E-mail support@MemexOEE.com 

Telephone 905-635-3042 8am - 5pm EST (UTC-4) Monday to Friday 

Internet http://support.memex.ca http://www.memex.ca/resources/support/ 

Support Policy To view the Memex support policy: visit memex.ca, point to Resources 
in the menu and then click Technical Support Policy. 
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Appendix A – Uninstalling, Reinstalling Moving or 

Repairing Dostek DNC 

Before you attempt to uninstall, reinstall, move or repair Dostek DNC, be sure to make a backup copy 

of your current Dostek DNC configuration files. See Section 4, “Making Backups.” 

To upgrade your Dostek DNC software to a newer version, see Section 1.5, “Upgrading from a 

Previous Version.” 

Uninstalling Dostek DNC 

To remove Dostek DNC from your computer, start by choosing either of the following methods to 

execute the Dostek DNC uninstaller: 

• Open file “unins000.exe” in the Dostek DNC software folder. The Dostek DNC folder is one of: 

“C:\Dostek DNC”, “C:\Program files\Dostek DNC” or “C:\Program files(x86)\Dostek DNC”. 

• Select, double-click or right-click “Dostek DNC” in “Add or remove programs,” “Programs and 

features” or “Settings,” depending on the Windows version. 

The uninstaller does not remove all Dostek DNC files. It will not remove files added to the “Dostek 

DNC” folder after installation, and it will not delete Dostek DNC configuration files. This is by design. 

To remove all remaining traces of Dostek DNC from the computer: 

1. Delete the Dostek DNC folder identified above. 

2. Delete the “C:\ProgramData\Dostek DNC” folder. If you are using Dostek DNC version 15 or later, 

you may want to make a backup copy of “Install-Backup” folder before deleting this folder. It 

contains a backup copy of the Dostek DNC installer. 

3. Open Windows Registry Editor (regedit) and remove registry key 

“Computer\HKEY_CURRENT_USER\Software\Dostek”. 

Reinstalling or Moving Dostek DNC 

Before you reinstall or move Dostek DNC, make a new backup copy of your Dostek DNC configuration 

files (Section 4, “Making Backups”). 

To reinstall or move your Dostek DNC software, you need your original software disk or download, or 

one of your backup copies. 

If you are unable to find your Dostek DNC software: 

• If you received a printed Dostek DNC manual, look inside the front cover for a small CD-ROM disk 

containing your software. 

• Search your computers for files matching “DDW*.exe” or “DDW*.zip”. 

• Download and install the Dostek DNC free trial on a new computer. The free trial works for 10 

days, providing you time to find your backup copies or purchase a software update from Memex. 

• If you are using Dostek DNC version 15, a copy of your Dostek DNC software installer is saved in 

folder “C:\ProgramData\Dostek DNC\Install-Backup”. 
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To reinstall Dostek DNC: 

1. Install Dostek DNC as explained in Section 2, “Installing Dostek DNC.” 

2. Copy your original Dostek DNC configuration files from your backup to Dostek DNC’s Settings 

folder. For Dostek DNC version 15, copy the files to “C:\ProgramData\Dostek DNC\Settings”. For 

versions prior to 15, copy the files to “C:\Dostek DNC\Settings”. 

Your Dostek DNC software license key is included in the backup copy of your Dostek DNC 

configuration. 

To move Dostek DNC to a different computer, follow the instructions for reinstalling (above), and then 

optionally uninstall Dostek DNC from the original computer. 

Repairing Dostek DNC 

To repair Dostek DNC, you can: 

• Reinstall Dostek DNC on the current computer as explained in “Reinstalling Dostek DNC,” above. 
If reinstalling does not correct the problem, try uninstalling Dostek DNC before you reinstall it. 

• Install Dostek DNC on a new computer, and then copy your Dostek DNC configuration files from 
the previous configuration or from your backup copies. 
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Appendix B - Disconnecting a Remote DNC Channel 

This appendix explains how to disconnect a CNC channel in the Dostek DNC Remote Server application 

so you can capture received data from the CNC using the Com Test Terminal (DTerminal) application. 

Capturing data received from the CNC is explained in Section 6.3, "Sending Captured CNC Output." 

When you are using the Dostek DNC Remote Server application (DRemote), you must "disconnect" the 

CNC channel before you can capture data using DTerminal. 

To disconnect the CNC channel: 

1. Select the CNC whose data you wish to capture in the MultiPort DNC channel list: The selected 

channel is highlighted. 

 

2. On the DRemote menu, click Channel, and then Disconnect. The channel's COM port is released 

(closed) so the port can be opened by the DTerminal application. 
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Appendix C – Working with USB/Serial Adapters 

USB/serial COM port adapters are a common source of problems when used for CNC communication. 

This note describes some of the problem symptoms and recommends steps you can take to avoid 

problems.  

USB/Serial Problem Symptoms  

Reports of defective USB/Serial adapters, even brand-new adapters, are common. USB/serial adapters 

have been found to operate at the wrong baud rate, send data but not receive data, and simply fail to 

work. 

Some typical problems encountered when using USB/serial adapters:  

• The Windows device driver produced by Prolific Technology has a serious bug with its XOn/XOff 

flow control function that affects communication with CNC machine tools. Products from many 

vendors use this device driver. The bug causes Dostek DNC to appear frozen with the message in 
the status panel indicating "0% 0 bytes" or "0% Line: 1".  

• Some USB/Serial adapters do not implement XOn/XOff flow control properly, which may result in 

the CNC reporting an "Overflow" or "Overrun" alarm when a file is sent from the computer to the 
CNC.  

• When a USB/Serial adapter is unplugged and reconnected while the computer is powered on, 

Windows may reinstall the device driver and assign the device a different COM port number. 
Dostek DNC displays error message "Unable to open COM port" the next time you attempt to use 
the adapter.  

Recommendations  

To avoid problems with USB/serial COM port adapters:  

• At the time of writing, the Digi Edgeport USB/serial adapter is the only USB/serial adapter 
recommended for use with Dostek DNC. This adapter is not perfect, but its problems are practical 
to work around. See Memex Application Note AN58, "Using Digi Edgeport USB-Serial Adapter." To 

view application notes, open Dostek DNC File Manager, point to Documents in the Help menu, 
and then click Application notes. 

• Keep the USB/serial adapter plugged in all the time, if possible. If you must unplug the adapter, 

plug it back into the same port the next time you use it. Otherwise, Windows may assign a 
different COM port number to the adapter, requiring a change to your Dostek DNC software 
configuration. 

• Avoid using USB/serial adapters that use Prolific Technology device drivers. To determine the 
provider of your USB/serial adapter's driver, open the COM port's properties pages in Windows 
Device Manager, and click the Driver tab.  

• For problem-free communication, use a high-quality single-port Ethernet/RS-232C adapter, such 

as Memex order number 4502-12.  
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Appendix D – Installing Communication Hardware 

Install your RS-232C communication hardware following the manufacturer’s instructions. Installation 

usually requires that you install the product’s Windows device driver software. 

If you are using a USB/Serial adapter, see Appendix C, “Working with USB/Serial Adapters.” 

If you are moving existing RS-232C communication hardware from an older computer to a new 

computer, consider the following: 

• If the existing hardware plugs into an expansion slot in your computer, it may not be compatible 
with the expansion slots in the new computer. 

• If the new computer is using a different version of Windows, you may need to obtain new device 
driver software from the hardware vendor. 

• If you are using multiple ports, Windows may not assign the same COM port number in the new 
computer as in the existing computer. You may need to re-assign COM ports in Windows Device 

Manager or in Dostek DNC to assign the correct port to the correct machine. See “Understanding 
Windows COM Port Assignments” below. 

Understanding Windows COM Port Assignments 

When you install RS-232C communication hardware, Windows automatically assigns a COM port 

number to each RS-232C port. 

When you move hardware to a new computer, Windows may not assign the same COM port numbers 

as it assigned for the previous computer. You must compare the port assignments, and if different, 

you must change settings in either of the following ways: 

• In Windows Device Manager, re-assign the COM port numbers to match the previous computer. 

• In Dostek DNC, change the “Computer COM Port” setting for each configuration to match the new 
port assignments. 

To view COM port assignments, open the “Ports (COM & LPT)” section in Windows Device Manager: 
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Appendix E – Building RS-232C Cables 

RS-232C communication cables are available from Memex. If you prefer to build a cable, diagrams for 

typical CNC applications are provided on the following page. The 3-wire cable is suitable for Xon/Xoff 

or DC-Codes flow control. The 5-wire and 7-wire cables are suitable for Xon/Xoff, DC-Codes and 

RTS/CTS (hardware) flow control. 

The cables work with most controls equipped with a “DTE” RS-232C connector pinout, including Fanuc, 

Mitsubishi, Okuma, Mazak, Haas, Yasnac and other controls. 

You can modify the cables as follows to work with other control models: 

• For control models equipped with a DB25P plug connector instead of a DB25S socket connector, 
you can substitute a DB25S socket connector for the DB25P plug connector. 

• For control models equipped with a "DCE" connector pinout, modify the cable as follows:  

o Reverse pins 2 and 3 at the CNC end of the cable.  

o Reverse pins 4 and 5 at the CNC end of the cable.  

o Reverse pins 6 and 20 at the CNC end of the cable.  

o Do not connect pin 8 at the CNC end of the cable.  

Cable Length 

The RS-232C standard suggests a maximum cable length of 50 feet. However, longer cables are often 

used. To use cables longer than 50 feet:  

• Use low-capacitance cable (less than 20 pf/ft).  

• Use shielded cable to reduce noise pick up. Connect the shield to the RS-232C frame ground or 

signal ground.  

• Keep cables as short as possible. Longer cables increase signal loss and increase the risk of noise 

pick up.  

• RS-232C signals are not electrically isolated. As longer cables are used, the risk of damage from 

electrical surges may increase as the possibility of differences in ground potential between the 
computer and CNC increases. Consider installing an optical isolator in the cable between the 
computer and CNC.  

• For longer distances, consider using single-port Ethernet/serial adapters. Benefits include:  

o Standard Ethernet wiring.  

o Cable length up to 300 feet.  

o Reliable error-correcting Ethernet communication protocols.  

o Electrical isolation of 1500 volts or more.  
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Appendix F- Using Dostek DNC COM Test Terminal 

(DTerminal) 

Dostek DNC COM Test Terminal (DTerminal) is helpful for troubleshooting RS-232C communication 

problems. 

You can use DTerminal to: 

• Automatically detect CNC baud rate, parity and data bit settings.  

• Easily experiment with communication settings such as baud rate and parity.  

• Display received data, including control characters that are not normally visible.  

• Send data and control codes by typing on the keyboard or by sending data from a text file.  

• Use ASCII, ISO, EIA-244 and hexadecimal data formats.  

• Control and display COM port modem control signals (DTR, DSR, CTS, RTS and CD).  

• Capture received data into a log file to examine, print or email.  

• Test cables, COM ports and CNC RS-232 serial ports using a variety of methods including 
loopback tests and continuous test patterns.  

• Analyze communication protocols.  

• Enumerate available COM ports.  

• Control and test the Dostek Model 440A Behind-the-Tape Reader (BTR) interface. 

To use DTerminal: 

1. Open Dostek DNC File Manager, point to the Tools menu and then click Com Test Terminal 

(DTerminal). 

2. For information about using DTerminal and its test features, point to Help topics in DTerminal’s 

Help menu. 
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